AW139M
SIMPLY NO RIVALS
DELIVERING CAPABILITY FOR DEMANDING MISSIONS

The AW139M is the military version of the AW139, the market leading intermediate twin-engine helicopter that sets the standard for all intermediate twins. Developed to meet the stringent military and civilian certification requirements of government, homeland security and military users, AW139M has been designed to perform a wide range of missions, day and night, in the most challenging environments.

Operators worldwide benefit from advanced technology, high power margins and inherent high levels of safety and survivability. Day/Night VFR and IFR operations are enabled by state-of-the-art digital avionics that enhance situational awareness and reduce pilot workload. The largest reconfigurable cabin in its class maximises operational flexibility and allows the rapid installation of mission, role equipment and weapons to meet operational requirements.

Combining cutting edge technology, unmatched performance and unrivalled safety, the AW139M is the best solution in the most challenging conditions, all over the world.

AW139M KEY FEATURES

AIR VEHICLE
› Compact footprint for confined area operations (Length Rotor Turning 16.66 m; Rotor Diameter 13.80 m)
› Fully articulated Main and Tail Rotors providing agile handling during Nap of the Earth (NOE) flight
› Main gearbox (60 min certified dry-run capable)
› Two turbo-shaft engines with engine burst containment
› Large Cabin 2.70 m (l) x 2.10 m (w) x 1.42 m (h); Cabin Volume 8 m³
› Large sliding doors (1.6 m wide) on Left Hand and Right Hand side
› Dual independent electrical and hydraulic systems
› Bird-strike resistance
› Crashworthiness to latest standards

CORE AVIONICS
› NVG Compatible Cockpit Display System with four 8” x 10” colour Active Matrix Liquid Crystal Displays
› Additional 5th Display in Cockpit
› 4-axis Digital Automatic Flight Control System enhanced with SAR modes and Hover mode.
› Flight Management System (FMS)
› Communication System including Dual VHF and Intercom System
› Navigation System including Dual VOR, DME, ADF
› Global Positioning System (GPS)
› Digital Maps and Tactical Data Display
› Identification Systems
› Enhanced Vision Systems
› Cockpit Voice & Flight Data Recorder
› Health & Usage Monitoring System
› Electronic Standby Instrument System (ESIS)
› HIRF / LEMP / EMC resistant
CABIN SPACE AND ACCESSIBILITY

Designed with inherent multi-role capability and flexibility of operation, the AW139M’s largest in class unobstructed cabin provides space for the rapid transport of heavily laden troops and mission equipment in support of high-tempo operations. Large sliding doors on both sides of the helicopter and low floor height enable rapid ingress and egress of troops, ease of loading and unloading of cargo and equipment and rapid loading of NATO stretchers on the ground. Fast roping and hoist operations through the large sliding doors enables troop insertion and extraction from the hover, whilst allowing simultaneous threat suppression from window mounted crew-served weapons.

The large cabin space enables the rapid installation of mission and role equipment including a fully integrated mission console. Additional mission equipment, such as stretchers and medical kit can be stowed in the large storage area behind the cabin. Optionally accessible from the main cabin in flight, it keeps cabin space free for operations.

The cabin can be rapidly reconfigured from Troop Transport and Cargo Re-Supply into more demanding configurations, including MEDEVAC, CASEVAC, SAR, SF/CSAR and C2/ISR.
MISSION & ROLE EQUIPMENT

A wide range of mission and role equipment can be installed on the AW139M, further enhancing its operational effectiveness. This includes, but is not limited to the following.

Role Equipment
› Inlet Barrier Filters
› Crashworthy Self-Sealing Fuel Tanks
› Ballistic Protection (Cockpit & Cabin Floor, Cockpit Doors)
› Wire Strike Protection System
› 360° Coverage Obstacle Proximity LiDAR System (OPLS)
› Searchlight (NVG Compatible)
› IR Formation Lights
› Overwater Kit (Emergency Flotation & Life Rafts)
› Mil GPS, IFF, TACAN

Utility Equipment
› Rappelling Hooks (3 LH + 3 RH)
› Fast Rope Attachments (RH & LH)
› Cargo Hook - Single or Dual HEC Type
› External Rescue Hoist - Single or Dual Type
› Folding Crashworthy Troop Seats
› Medical and Casualty Evacuation System (up to 4 stretchers)
› Internal Auxiliary Fuel Tank
› Full Ice Protection System

Avionic Equipment
› Military Communications including Secure Radios with TACSAT capability, Combat Tactical Radios, Blue Force Tracker, Personnel Locator System, Video Downlink, Tactical Data Link
› Mode 5 IFF transponder
› Defensive Aid Suite including Radar Warning Receiver (RWR), Laser Warning Receiver (LWR), Missile Warning System (MWS) and Countermeasure Dispensing System (CMDS), Direct InfraRed CounterMeasure System (DIRCM)
› Electro-Optic / Infra-Red (EO/IR) sensor with optional Laser Range Finder / Designator
› Mission Console in cabin providing Tactical Awareness, Link Management and C2/ISR
› Weather / Search Radar

Weapon Systems
› Observation and Targeting System
› Internal: 2 x Sniper Rifle
› Internal: 2 x 7.62 mm Pintle Mounted Machine Guns (Door / Window)
› External: 2 x 12.7 mm Gun Pod (250 or 400 rounds)
› External: 2 x Combined 12.7 mm Gun Pod / 3 Tube 70 mm Rocket Launcher
› External: 2 x 70 mm Rocket Launchers (7 or 12 Tubes)
AW139M CHARACTERISTICS

WEIGHT (MTOW)
Max Take Off Weight (Internal) 6,400 kg (14,110 lb)
Increased Gross Weight 6,800 kg (14,991 lb)
Increased Gross Weight (1) 7,000 kg (15,430 lb)

PROPULSION
Powerplant 2 x Pratt & Whitney Canada PT6C – 67C engines with FADEC

ENGINE RATINGS
Take-Off Power (5 mins) 2 x 1,252 kW (2 x 1,679 shp)
Max Continuous Power 2 x 1,142 kW (2 x 1,531 shp)

CAPACITY
Crew 1 to 2
Passengers Up to 15

DIMENSIONS
Overall Length (2) 16.66 m (54 ft 08 in)
Overall Height (2) 4.98 m (16 ft 04 in)
Rotor Diameter 13.80 m (45 ft 03 in)

PERFORMANCE (ISA, SL, MTOW)
VNE (IAS, SL) 309 km/h (167 kt)
Max Cruise Speed (TAS, SL) 306 km/h (165 kt)
HIGE (TOP) 4,682 m (15,360 ft)
HOGE (TOP) 2,478 m (8,130 ft)
Service Ceiling (MCP) 6,096 m (20,000 ft)
Maximum Range (3) 1061 km (573 nm)
Maximum Endurance (3) 5 h 13 min

(1) Available as Kit
(2) Rotor turning
(3) No Reserve, with Auxiliary Tank
MULTI-ROLE CAPABILITY

TROOP TRANSPORT
The rapidly reconfigurable cabin provides crashworthy seating for up to 15 lightly equipped troops or 10 fully equipped troops in fore/aft and sideways facing layouts. Ballistic protection as well as crew served weapons, such as 7.62 mm GPMG or Sniper Rifles located in the forward cabin windows or in cabin door, can be provided.

CARGO RE-SUPPLY / EXTERNAL LIFT
The large 8 cu metre constant section cabin, flat floor and large 1.6 m wide cabin doors enable rapid loading and unloading of cargo and equipment. Coupled with a 2,200 kg cargo hook capability, with “in cockpit” monitoring the helicopter has the capacity to conduct effective resupply and lift operations.

CASEVAC / MEDEVAC
The rapidly reconfigurable cabin enables designation for medical operations. In addition to 4 forward facing seats, 2 stretchers can be mounted transversally on the flat floor to enable full body access to patients or 4 NATO stretchers can be carried in a floor mounted module. Attachment points and power outlets are provided for medical equipment. A 3 stretcher medical module is available for more demanding missions.

SEARCH & RESCUE
The cabin can be rapidly reconfigured with seats for hoist operator and medic providing unobstructed space for hoist operations and patient recovery through the large cabin door. In-flight access to the 3.4 cu metre rear stowage bay enables SAR mission equipment to be stowed outside of the cabin area. Optional mission consoles enhance situational awareness and search capabilities to further increase mission effectiveness.

SPECIAL FORCES OPERATIONS & COMBAT SAR
Centrally mounted sideways facing or back-to-back seat layout enables rapid egress and ingress of a Special Forces (SF) team through the large sliding doors. The fast roping system enables simultaneous egress of two troops per side. The rescue hoist can be used to recover SF teams while hovering. Threat suppression is provided by crew served weapons in the forward windows.

COMMAND & CONTROL (C2), COMMUNICATIONS, COMPUTERS (C4), INTELLIGENCE, SURVEILLANCE & RECONNAISSANCE (ISR)
Battlefield capabilities from C2 to C4ISR are provided depending on the mission by means of a dedicated console in the cabin integrated with the AW139M mission management, mission systems and sensors. This enables the AW139M to collect, produce and disseminate time critical C2 and ISR information to the Force.

CLOSE AIR SUPPORT/ARMED ESCORT
Close Air Support and Armed Escort capabilities are provided by the AW139M sighting, targeting and external weapon systems that complement window and door mounted crew served weapons. Heavy machine gun pods and guided / unguided rockets provide scalable threat suppression capabilities to enhance combat effectiveness.

MARITIME CAPABILITY
The AW139M provides intermediate class multi-role maritime capability. Lashing points and folding main rotor blades enable the AW139M to be secured during adverse weather conditions and stowed in suitably sized hangars. The wheeled undercarriage enables easy helicopter movement using handling systems. AW139M has the capability to operate within the electro-magnetic environment associated with ship operations.
SURVIVABILITY & CRASHWORTHINESS

Leveraging the major contributions to battlefield survivability made by Doctrine and Training, and Intelligence, Mission-Planning and Re-Planning, the AW139M will survive in the modern battlefield. Platform and mission systems capabilities enable the AW139M to avoid threats, avoid detection by threats, avoid acquisition by threats and avoid a hit.

### AW139M PLATFORM & SYSTEM CAPABILITIES

<table>
<thead>
<tr>
<th>PLATFORM CAPABILITIES</th>
<th>Avoid Threat</th>
<th>Avoid Detection</th>
<th>Avoid Acquisition</th>
<th>Avoid Hit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Range / Endurance (for routing / re-routing)</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
<td>✔️</td>
</tr>
<tr>
<td>Agility / Performance for NOE flight (terrain masking)</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Power margins for Hot &amp; High / Performance</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>De-Icing / Anti-Icing for Winter Operations</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Low Signatures (Visual, Acoustic and IR)</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SYSTEM CAPABILITIES</th>
<th>Avoid Threat</th>
<th>Avoid Detection</th>
<th>Avoid Acquisition</th>
<th>Avoid Hit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day Night All Environment Operations</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Off-Board Mission Planning</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Situational Awareness: Digital Map</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Threat warning and geo-location: Radar / Laser / EW</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Comprehensive Voice, Video and Data Comms</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>On-Board Mission Re-Planning</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Synthetic Vision / Terrain Avoidance Systems</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Sensors / Weapons capability – stand off from threats</td>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
<td></td>
</tr>
<tr>
<td>Counter threat (Chaff &amp; Flare etc.)</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Threat Suppression</td>
<td>✔️</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

AW139M can survive small arms fire due to its inherent ballistic tolerance provided by damage tolerant / fail-safe rotor blades, airframe structure and components, run-dry main gearbox, twin engines with fire suppression and turbine burst containment, dual electrical and hydraulic systems, ballistic tolerant / self-sealing fuel tanks and ballistic protection of critical components. In the event of a crash, the AW139M provides crash protection and structure, crashworthy pilot, co-pilot and troop seats and restraints, crashworthy fuel tanks to minimize post-crash fire, flotation equipment for maritime operations, and rapid post-crash / post-ditching egress.
Leonardo’s Helicopter Division Support mission is to assist Customers to perform their missions successfully. Fundamental to this mission is to ensure that operational safety is as high as possible. The Helicopters Division continues to develop its support services and advanced solutions in line with Customer’s evolving requirements.

Today the Helicopters Division offers a full range of services to Customers. These can be contracted individually or organised under some form of integrated support scheme where the Helicopters Division is responsible for performance elements that vary from logistic support guarantee up to helicopter availability, moving the boundaries of traditional support. In the most comprehensive schemes the Customer specifies where and when he wants to fly and the Helicopters Division is accountable and responsible for the complete service.

The range of services includes:

› **Spare & Repairs:** the Material Support Services Organisation is accountable for all material and logistics aspects of spares, repairs and overhauls, including a material AOG service. The organisation can also provide logistic modelling.

› **Maintenance:** in support of customers worldwide, the Helicopters Division can provide line and base maintenance at Customers facilities, utilising an extensive network of maintenance centres, or through company-owned and third party organisations.

› **Technical Services:** an extensive range of capabilities exist including the latest standards of integrated electronic technical publications, technical query resolution, repair design and modification assistance.

› **Advanced Services:** including remote support to the technicians through augmented reality, HUMS analysis, flight planning tools, various logistics packages, electronic replacements for traditional paperwork systems and online portals for direct access to company data.

› **Fleet Operations Centres:** located across the globe, available 24/7, to promptly help Customers resolve issues and get back to flight.
Leonardo, through its Helicopters Division, is a world leading provider of professional training services, systems and solutions to a global customer base. The company is fully committed to a training policy that enables our customers to make the most effective safe use of their helicopters.

With over 300 professional training personnel, the Helicopters Division has delivered essential training to the world’s helicopter operators for over 65 years. Our team includes flying and technical instructors with considerable military and civilian helicopter experience. The training capability for the AW139M, at the Training Academies in Sesto Calende in Italy, in Philadelphia in the United States and in Kuala Lumpur in Malaysia, features the latest synthetic training devices combined with a comprehensive programme of training courses for air crew, rear crew, ground crew and maintainers. In addition, the Helicopters Division is developing a network of regional Training Centers to ensure that customers can access world-class training at a time and place convenient to them.

The range of training solutions is evolving constantly. Services include type rating courses in conjunction with basic training, refresher training and complete turnkey solutions. Leonardo’s Helicopters Division is also focusing on a variety of mission specific training so that customers can do more with their aircraft to deliver total crew operational capability.

To meet the demands of an ever changing operating environment our Simulation Learning & Support Services Systems (SL&SS) teams have leveraged Commercial-Off-The-Shelf technology combined with OEM software solutions to provide award-winning, cost effective training devices. These range from simple computer based training courses through to maintenance training devices and full flight simulators.